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Release Notice
This is the April 2017 release of the Trimble RealWorks
Software Release Notes. It applies to version 10.3 of the
Trimble RealWorks software.
The following limited warranties give you specific legal
rights. You may have others, which vary from
state/jurisdiction to state/jurisdiction.
Software License, Limited Warranty
This Trimble software product, whether provided as a
standalone computer software product, built into hardware
circuitry as firmware, embedded in flash memory, or stored
on magnetic or other media, (the “Software”) is licensed
and not sold, and its use is governed by the terms of the
relevant End User License Agreement (“EULA”) included
with the Software. In the absence of a separate EULA
included with the Software providing different limited
warranty terms, exclusions and limitations, the following
terms and conditions shall apply. Trimble warrants that this
Trimble Software product will substantially conform to
Trimble’s applicable published specifications for the
Software for a period of ninety (90) days, starting from the
date of delivery.
Warranty Remedies
Trimble's sole liability and your exclusive remedy under the
warranties set forth above shall be, at Trimble’s option, to
repair or replace any Product or Software that fails to
conform to such warranty (“Nonconforming Product”) or
refund the purchase price paid by you for any such
Nonconforming Product, upon your return of any
Nonconforming Product to Trimble in accordance with
Trimble’s standard return material authorization
procedures.
Warranty Exclusions and Disclaimer
These warranties shall be applied only in the event and to
the extent that (i) the Products and Software are properly
and correctly installed, configured, interfaced, maintained,
stored, and operated in accordance with Trimble's relevant
operator's manual and specifications, and; (ii) the Products
and Software are not modified or misused. The preceding
warranties shall not apply to, and Trimble shall not be
responsible for defects or performance problems resulting
from (i) the combination or utilization of the Product or
Software with hardware or software products, information,
data, systems, interfaces or devices not made, supplied or
specified by Trimble; (ii) the operation of the Product or
Software under any specification other than, or in addition
to, Trimble's standard specifications for its products; (iii) the
unauthorized, installation, modification, or use of the
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Product or Software; (iv) damage caused by accident,
lightning or other electrical discharge, fresh or salt water
immersion or spray; or (v) normal wear and tear on
consumable parts (e.g., batteries). Trimble does not
warrant or guarantee the results obtained through the use
of the Product.

THE WARRANTIES ABOVE STATE TRIMBLE'S ENTIRE
LIABILITY, AND YOUR EXCLUSIVE REMEDIES,
RELATING TO PERFORMANCE OF THE PRODUCTS
AND SOFTWARE.EXCEPT AS OTHERWISE
EXPRESSLY PROVIDED HEREIN, THE PRODUCTS,
SOFTWARE, AND ACCOMPANYING DOCUMENTATION
AND MATERIALS ARE PROVIDED “AS IS” AND
WITHOUT EXPRESS OR IMPLIED WARRANTY OF ANY
KIND BY EITHER TRIMBLE NAVIGATION LIMITED OR
ANYONE WHO HAS BEEN INVOLVED IN ITS
CREATION,
PRODUCTION, INSTALLATION, OR DISTRIBUTION
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, TITLE, AND
NONINFRINGEMENT. THE STATED EXPRESS
WARRANTIES ARE IN LIEU OF ALL OBLIGATIONS OR
LIABILITIES ON THE PART OF TRIMBLE ARISING OUT
OF, OR IN CONNECTION WITH, ANY PRODUCTS OR
SOFTWARE. SOME STATES AND JURISDICTIONS DO
NOT ALLOW LIMITATIONS ON DURATION OR THE
EXCLUSION OF AN IMPLIED WARRANTY, SO THE
ABOVE LIMITATION MAY NOT APPLY TO YOU.
TRIMBLE NAVIGATION LIMITED IS NOT RESPONSIBLE
FOR THE OPERATION OR FAILURE OF OPERATION OF
GPS SATELLITES OR THE AVAILABILITY OF GPS
SATELLITE SIGNALS.
Limitation of Liability
TRIMBLE’S ENTIRE LIABILITY UNDER ANY PROVISION
HEREIN SHALL BE LIMITED TO THE AMOUNT PAID BY
YOU FOR THE PRODUCT OR SOFTWARE LICENSE. TO
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, IN NO EVENT SHALL TRIMBLE OR ITS
SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES
WHATSOEVER UNDER ANY CIRCUMSTANCE OR
LEGAL THEORY RELATING IN ANY WAY TO THE
PRODUCTS, SOFTWARE AND ACCOMPANYING
DOCUMENTATION AND MATERIALS, (INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS), REGARDLESS WHETHER
TRIMBLE HAS BEEN ADVISED OF THE POSSIBILITY OF
ANY SUCH LOSS AND REGARDLESS OF THE COURSE
OF DEALING WHICH DEVELOPS OR HAS DEVELOPED
BETWEEN YOU AND TRIMBLE. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE
ABOVE LIMITATION MAY NOT APPLY TO YOU.
NOTE: THE ABOVE LIMITED WARRANTY PROVISIONS
MAY NOT APPLY TO PRODUCTS OR SOFTWARE
PURCHASED IN THE EUROPEAN UNION. PLEASE
CONTACT YOUR TRIMBLE DEALER FOR APPLICABLE
WARRANTY INFORMATION.
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Introduction
Trimble RealWorks (TRW) software is an integrated software suite for surveyors and engineers that takes
advantage of point cloud data sets. Trimble RealWorks is full-featured software that enables you to visualize,
explore, register and manipulate an as-built scene of point cloud data. It incorporates a set of useful tools and
empowering functions that are particularly suited to civil survey, building, heritage, forensic, plant and other
applications. It also allows surveyors and engineers to produce compelling 2D and 3D deliverables for direct
output or export to AutoCAD® and MicroStation®.
Trimble RealWorks software is available in a selection of formats ranging from a base version, which includes
standard registration and contouring functionalities, to a full function version including all editions. The software
allows surveyors and engineers to offer enhanced deliverables in both 2D and 3D format, which clients can then,
for example, visualize, manipulate, print, or partially edit.
With Trimble RealWorks Advanced, users have access to advanced registration features and can also leverage
the powerful 2D/3D inspection tools as well as cross-section, ortho-projection and profiling features to produce
compelling civil survey deliverables.
Trimble RealWorks Advanced-Modeler edition provides a fast and intuitive 3D modeling capability. It is
particularly suited to civil engineering surveys and applications such as site refurbishments where modeled and
textured structures enhance or complete the impact and scope of a surveyors' or engineers' final deliverable.
The Trimble RealWorks Advanced-Plant edition, which includes all modeling functions, provides powerful tools
for various tasks specifically related to the power, process, plant and related environments.
The Trimble RealWorks Advanced-Tank edition includes all features included in Advanced-Plant plus additional
tools specifically for the storage tank inspection and calibration market.
To further enable surveyors and engineers to communicate their results to clients and stakeholders, and to reach
new levels of success, RealWorks offers its Publisher capability. With Publisher users can prepare selfcontained packages that enable final clients, colleagues, and partners to visualize and explore projects in 2.5D,
extract 3D information as well as measure and annotate. Trimble continues to also provide the RealWorks
Viewer utility for visualization and analysis of 3D data with Trimble RWP files.

System requirements






®

®

Operating system: Microsoft Windows 7,8 and 8.1,10 - 64-bit
Processor: minimum 2.8Ghz (Quad-Core) or higher, (additional cores with Hyper-Threading support
strongly recommended)
RAM: minimum 8GB (16GB and higher recommended)
VGA card: OpenGL 3.2 compatible with minimum 1GB VRAM (3GB or higher recommended)
3-button mouse
Other requirements:
Solid State Drive (SSD) for maximum performance (pref. 500GB) – strongly recommended.
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Data Processing
Description

New or
changes

Feature

Benefit
/comments

Improved
color
blending of
Trimble TX
series scans

Enh

When opening TZF scans acquired
by the Trimble TX6 or the Trimble
TX8 with images, the transition
between overlapping images is now
smoother,
making
the
color
information
more
homogeneous
across the entire scan.

Better data quality. This results
in a better visualization in Scan
Explorer as well as on the
extracted point clouds in the
application's 3D view.

Auto-Classify
Indoor:
detection of
floor
(concrete vs
grated),
ceiling and
walls

New

New fully automatic classification of
point clouds of indoor environments.
Auto-Classify Indoor is a new tool in
Production configuration, available
from the Cloud panel of the Edit tab.
This tool automatically classifies point
clouds of an indoor environment into
several classes: Floor, Grated Floor,
Ceiling, Walls, and Remaining. This
tool is intended to work on point
clouds containing a single floor. In
case of multiple floors, you must first
manually separate each floor, e.g.,
using Scan-based Sampling.

Better data analysis, improved
productivity. Enhanced handling
of classified datasets.

Auto-Classify
Outdoor:
power line
detection

New

The existing Auto-Classify tool,
renamed Auto-Classify Outdoor, now
offers a new option of 'Power Line'
class. When selected, the function
creates a single cloud with all found
power lines, in the 'Wire - Conductor
(Phase)' layer. In the LAS Export,
point clouds in this layer are exported
using the LAS ID #14.

Better data analysis, improved
productivity. Power line
extraction is useful to visually
inspect vegetation
encroachment in
transmission/distribution
corridors. It can also be used in
conjunction with the Catenary
Drawing tool to produce CAD
models of existing electrical
lines.

Improved
performance
of targetbased
registration
tool

Enh

Matching targets between station
groups is now much faster on
projects with hundreds of stations
and thousands of targets. The new
optimized algorithm uses parallel
processing to yield the same result in
a shorter computation time.

Improved productivity. Take
benefit of your computer's multicore processor.
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Visualization and Navigation
Description

New or
changes

Feature

Benefit
/comments

Magnifier
mode

New

A new efficient way to visually inspect
details in the point cloud is now
available. To quickly view the area
just around the cursor, press and
hold the N key to activate the
Magnifier mode. This will set the
viewpoint, and only display the points
in the immediate vicinity. You can
pan, rotate and pick points while in
this mode. Use the + or – button on
the numerical keyboard to increase or
decrease the size of the viewing
area. Use the * key to reset to the
default size. To change the default
size, go to 'Preferences > Navigation
> Magnifier Mode'. The preferences
dialog also contains an option to
move the mouse cursor location to
the center of the screen when using
the magnifier mode. The magnifier
mode is ideal for quickly inspection
specific areas of the point cloud or for
picking and ensuring the correct point
is picked.

Improved navigation,
visualization and scene
understanding. When
inspecting details in a large
environment, the Magnifier
mode enables an efficient
interaction because you avoid
frequently zooming in and out:
you can stay at an overall
viewing distance, switch to a
close view when needed by
pressing the N key, then go
back to the initial view just by
releasing the N key. You may
even use this mode while in
Station-based mode: you will
then be able to turn around
objects while the magnifier
mode is active, which yields a
very intuitive and powerful way
to navigate the data.

Point cloud
rendering:
Visibility and
Shading
groups

New

Several new point cloud renderings
have been made available in this
version aimed at improving the way
to visualize and interpret the scan
data. These renderings have been
grouped in two drop-down lists:
Visibility
and
Shading,
now
accessible in the display/navigation
vertical toolbar. The Visibility group
contains modes for displaying only
what you would like to see: No filters,
Hide Background, See Inside (new),
Outline (new). The Shading group
contains modes that highlight details
depending on the data content: No
Shading, Ambient Shading (new),
Normal Shading. Combine the
Visibility, Shading, Color and Point
size options to best match the
specific visualization needs of your
datasets.

Improved visualization and
easier scene understanding.
With all the options available, it
is now possible to get realistic
views in various contexts: data
with no normal information
(e.g., handheld or mobile scan
data), data with poor laser
intensity, etc.
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Point
Shading:
Ambient
Shading

New

This mode shades each point relative
to the amount of ambient lighting it
receives. This shading reveals the
details. Since it applies on all
datasets - it doesn't require normal
information or intensity or color - this
is the recommended mode for most
situations, combined with your
favorite color and visibility options.

Improved visualization and
easier scene understanding.
This innovative rendering mode
is particularly useful when no
normal information is available.

Point
Visibility: See
Inside

New

This mode hides the points acquired
from behind. This is useful when
looking at indoor scans from an
outside viewpoint: the first wall will be
hidden to let you view the inside. This
mode requires points to have normal
information.

Improved visualization and
easier scene understanding.

Point
Visibility:
Outline

New

This mode hides all the points on
surfaces facing the current view. This
is particularly useful for indoor
environments. This mode requires
points to have normal information.

Improved visualization and
easier scene understanding.
For structured environments,
you can quickly visualize a 2D
plan type view simply by using
the Outline mode and viewing
from the top.

Feature

Benefit
/comments

You can now create videos of
significantly higher image quality.
When ticking the 'High Quality' option
in the Video Creator tool, the
produced video now shows more
point cloud details and less visual
artifacts - flickering and aliasing are
highly reduced. This is especially
visible when the point clouds consist
of several scans acquired from
different stations. Note that this
option can be combined with all the
point cloud color, visibility and
shading modes, including the new
modes introduced in this version, for
obtaining results that best fit your
needs. You can still use the 'Quick
Processing' option for generating a
video more quickly, e.g., for
producing a first draft version.

Improved communication,
better visuals.

Media
Description

Video Creator
high quality
option

New or
changes

Enh
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Improved
Screen
Capture

Enh

Like the Video Creator, 'Screen
Capture (High Res)' now produces an
image of higher quality. The aliasing
effect related to point clouds is highly
reduced. Note that since the created
image is larger than the screen, you
may want to increase the point size to
get a visually similar result.

Improved communication,
better visuals.

Feature

Benefit
/comments

Data Exchange
Description

New or
changes

Direct link to
AutoCAD®

New

Trimble RealWorks can now directly
send point clouds to Autodesk
AutoCAD® for an intuitive and
productive combined workflow. All
you need to do is to start AutoCAD®
from RealWorks (go to 'AutoCAD® >
Open AutoCAD®' in the Home tab in
Production), select the desired point
clouds, and press 'Export to
AutoCAD®'. This creates point
clouds, in RCP format, directly in the
open session of AutoCAD®. The
exported scan points may contain
color, laser intensity, and surface
normal information. This feature is
compatible with versions 2015
(R20.0), 2016 (R20.1) and 2017
(R21.0) of AutoCAD®. Autodesk
Recap® Pro needs to be installed,
with a proper license, to be able to
use this feature.

Productivity. Efficient workflow
by simultaneous use of Trimble
RealWorks and AutoCAD®.
AutoCAD® and AutoCAD
Civil3D® users can efficiently
extract small segmented areas
of interest and produce
deliverables from them.

Publish using
all scan
points

Enh

Share full resolution scan data with
your customers. When running
Media>Sharing>Publish, in 'Data
File', there is now a new option 'Full,
no sampling'. This creates a
published project in which each scan
has the same resolution as the TZF
Scans in the original project.

Better data interoperability.
When applicable, share the full
data with your customers.

FLS import:
luminance
correction
option

Enh

The FLS import dialog has been
enriched to enable you to choose to
apply luminance correction when
converting the data to a TZF Scan.
This way, you can compensate for a
too bright or too dark laser
luminance.

Better data quality.
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LAS/LAZ
export:
survey feet
and US
Survey feet

Enh

You can now choose units (meters /
survey feet / US survey feet) when
exporting clouds or scans to LAS/LAZ
format.

Better data interoperability.
Useful when working with thirdparty software solutions that
read the data without taking
units into account.

CAD Drawing and Surfaces
Description

New or
changes

Feature

Benefit
/comments

Smart picking
for curb and
gutter

New

Automatic detection of accurate curb
/ gutter points from rough user picks.
In the picking toolbar, two new
options have been added: 'Face of
Curb' and 'Gutter'. These two new
picking modes enable you to
precisely define a point on the top of
the curb or on the flowline. Roughly
pick a point near the edge of the
sidewalk,
the
software
will
automatically compute the best
curb/gutter point in the neighborhood.
These picking modes may be used in
the Polyline Drawing tool, the Feature
Set tool and the Measurement tool.
To check the results without having to
zoom in, you can use the new
Magnifier mode - by pressing the N
key.

Productivity, accuracy / quality
of deliverables. Quickly draw a
curb or gutter line without
having to frequently zoom in
and out.

Improved
projectionfree mesh
creation

Enh

In the Mesh Creation tool, the
algorithm has been improved when
using the 'No Projection' option. The
new algorithm now gives results of
better quality. Based on parallel
processing, it is also much faster than
the previous algorithm. When the
input points have normal information,
this information is used in the
computation for yet better results and
efficiency.

Enhanced productivity and data
quality.

Mesh shading

New

In View > Rendering, the 'Smooth
meshes' option has been added.
When selected, the existing smooth
normal shading is used for meshes.
When unselected, flat shading is
used: every triangle is shaded using
its surface normal only.

Improved visualization and
easier scene understanding.
The flat shading may be useful
when performing a visual
inspection, in particular
triangles in a mesh.
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Improved
performance
of mesh
visualization

Enh

The performance of the mesh
rendering has been improved for
recent graphics cards. Displaying
meshes with a few million points is
smooth on such setups.

Improved visualization
performance.

Feature

Benefit
/comments

Inspection
Description

New or
changes

Alignment
stationing in
Inspection
Map Analyzer

Enh

If you add stationing information to an
alignment, and use this alignment as
3D path for an inspection map, every
position along the path is referenced
with respect to the stationing. In
particular, in Inspection Map Analyzer
> Sections and Shifts, you can now
define the position of the slider by
typing the distance along the
alignment as defined by the
stationing,
using
the
current
stationing display format. This
information will appear in the 2D plot
view in the Map Analyzer tool as well
as in the name of the created or
exported sections.

Enhanced usability. Better
interoperability. Better
compliance to standards.

Alignment
stationing
display
format

Enh

The labels of the stations along an
alignment can now be viewed using
different formats: No formatting
(1000.00), 2 digits (10+00.00), 3
digits (1+000.00). To change this, go
to Preferences > Unit > Alignment
Stationing.

Enhanced usability. Better
compliance to standards.

Floor
Flatness:
improved
map

Enh

For clarity, the generated map in
Floor Flatness Inspection tool doesn't
use the scientific notation any more.

Enhanced usability.
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User Interface
Description

New or
changes

Feature

Benefit
/comments

Vertical
navigation/di
splay toolbar

New

A new vertical toolbar has been
added to the user interface, next to
the 3D view. It contains the most
commonly used navigation/display
commands:
limit
box
mode,
navigation type, projection type,
zoom extents, zoom on selection,
standard views, hide all, show
station, show station labels, point
color, point size, point visibility, point
shading. These frequently used
commands have been removed from
all tabs except View for improving
clarity in the ribbon.

Enhanced usability. Quicker
and easier access to the
command you need when
navigating - specific tabs in the
ribbon are now more
lightweight.

Better default
Quick Access
Toolbar

Enh

Segmentation and Sampling are now
by default in the Quick Access
Toolbar, at the top of the application.
This provides quick access to these
commands at any time, always from
the same location. Please note that
the
quick
access
toolbar
is
customizable.

Enhanced usability. Quicker
and easier access to the
commands you need.

Improved
interaction
with Scan
Explorer

Enh

It is now possible to open Scan
Explorer from the main Trimble
RealWorks window without the need
to first save the project. The
interaction in Scan Explorer is also
more direct: there is no longer the
need to set the focus on it to
navigate.

Enhanced usability. You can
now use Scan Explorer at any
time.

RESOLVED ISSUES

LAS Import unit improvement: some cases were not handled
DotProduct import: some files didn't import correctly
Display: fixed instability on all AMD Firepro graphics cards (W7100, W5100) with driver 16.Q4 and
newer.
Display: the amount of available VRAM on the graphics card was sometimes incorrectly read
Sampling tool>Scan-based: fixed UI issue with plus and minus buttons
Surface to Model Inspection: fixed issue in the first column of the inspection map when using tunnel
projection
Surface to Model Inspection: some maps were incomplete when using the 'vertical' option in step 1
Inspection Map Analyzer: fixed some inconsistencies in the plot view caption when using alignment
stationing
Tank Inspection: fixed case where 'Measure Tank' didn't work
Camera Matching tool: markers were hidden when using the Limit Box
Installer: fixed conflict with Faro DLL
Picking: Lowest/Highest picking option did not work properly on some data sets
END
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